
INTRO TO BLENDER MESH MODELING-PART1 
Basics of the Blender Interface and 3D View  

By Mr. D at Delta 3D  
 
 

  One of the first things to remember about Blender is that it is setup almost as two 
programs.  One is for real time use with the Blender Game engine, the other to produce 
images and animations used canned; or pictures and movies that are not designed to run 
real time in the Blender game engine. 
  Certain actions apply to both real time and canned objects, and some are designed more 
for one type of work or the other.  So in developing your workflow in Blender it may 
differ depending on what the destination of your final output will be.   
  Also if you are using Blender to produce artwork for a game engine other than 
Blender’s may effect what you can and can not do.  So if you do not know what your 
engine can handle art wise it is good advice to do so before you begin building art assets 
for your project. 
 
   When opening Blender you see a 
work area composed of multiple 
Window Work Areas, with each 
area having a Window 
Header/Menu Bar that lists actions 
that maybe carried out in that 
window type.  At the far left of the 
Header Menu Bar is an icon to 
control the type of window it is. 
 
Note:  Blender easily allows for 
resizing of ‘Work Areas’, and 
whether the menu bar appears at the 
top of a Window, bottom, or not at 
all.  Later you find out how to do 
this. 

  Here are two ‘Header/Information Menu Bars’ for the 3D View and Timeline 
Window Types.  A few first things, far left the Window Type Icon, sets what type of 
window you are in.  Notice this icon has small up/down arrows at the side of the icon, 
this indicates other types of modes are available.  Those modes refer to the icon type, so 
on that icon other choices would be for the various modes of ‘Window Type’.   



  Notice further down where it says ‘Object Mode’  this icon’s arrow are for ‘Editing’ 
choices, so selecting it’s icon lists the ‘Editing Modes’ available. 
  Icon boxes with left/right arrows indicate a numeric icon, meaning you can change the 
number in the ‘Icon Box’.  Do this using the arrow icon to increase or decrease the value, 
or clicking on the number or word in the icon (such as ‘Start:’ #) will allow for numeric 
input from your keyboard. 
 
  Immediately to the left of the ‘Window Type’ Icon is an arrow that controls whether 
the ‘Actions’ hot area selections are seen or not.  Click it to hide or show these ‘Actions’. 
The ‘Actions’ themselves may change with ‘Window Type’, in the example above 
you’ll notice View stays but the other two actions change, and there can be more or less 
actions.  Just remember certain actions can be carried out only in certain windows. 
 
  On the ‘Menu Bar’ the listed ‘Action Types’ where the words are ‘hot’ areas that when 
clicked on bring up a list associated with that Action.  Within the Action List can be 
further sub-lists branching off them main item.  Also shown are the keyboard shortcuts 
for the action.  

 
 
 
 
 
 
 
 
 
 
 
 

Menu Icons plus Mode/Type options 

                                                                                         Action hot area plus Actions list 

   

               

                                                                                                   

 
  
                                                                                             And sub-lists 
 
 
  
 
 
 
 
       Timeline Start value changed using Right/Left Arrows, 
                       and opening a numeric input in the icon      
 
  
 
 



 
 

WINDOW TYPES USED IN MESH MODELING 
 

hese ‘Window Types’ tend to be the most common ones you might choose to have 

SER PREFERENCES:  Start new projects, load and save projects. Render 

‘Full Ren
nd 

he armature for building an animation skeleton and creating object groups. 
ting 

ork area are options to help control Display, Menus, 

CAUTION:

T
available when mesh modeling. 

 
U
images and animations, but remember these are camera based renderings, or 
ders’ not working window quick renders, no camera no U.P. >Render 

   New object types are added here including mesh primitives, curves, cameras, a
lights. 
  Also t
‘Timeline’ has animation controls, and ‘Game’ for preparing objects for use and tes
as Blender Engine game assets. 
  Within the ‘User Preferences’ w
and Tool Box pause time among others. 
 

  In a normal default 
k 

 

an 

eal 

Useful Tips:

install the ‘User Preferences’ wor
area is hidden away at the top of the 
screen.  The Work Window has been 
pushed upwards till only the Header 
Bar shows.  To see the whole window
move your mouse up to the ‘User’ 
Header Bar and it should change to 
Up/Down Arrow.  Click and drag 
down to resize the window and rev
the Work Area. 
 
 
 
 

 
    If you are more use to another program sure as 3dsMax or Maya, within 

, 

 keep. 
re to 

BUTTONS WINDOW:  This is where you choose menu icons to do things 

sub category ‘Views & Controls’ you might try these.  1) Display:  turn on View Name
to turn on your 3D View Window’s name.  2) Select With:  you my like using the left 
mouse button to select with than the right.  3) Mouse Wheel: try it inverted. 
  ‘Auto Save’ sub category sets how often to save and how many versions to
  ‘File Paths’ set to place where you plan to save your project’s files if you don’t ca
use Blender defaults. 
 

like make a material, and assign it to an object (Shading icon).  Create 
‘special Objects’ like particle systems, or forces (gravity, wind…), and 
tems (Object icon). deflector sys



  You can create vertex groups, assign smoothing, add a modifier to and object (lattice, 

V/IMAGE EDITOR: Here you assign and manipulate uv co-ordinates for a 

 
OTE: 

boolean, mirror…) (Edit icon);  or set rendering options for your scene (Scene icon). 
3D VIEW:  Your main modeling work area, more on this further down. 
 
 
U
mesh. 
 

N  These Menus have more functions, and you should explore around on your own 

So since Blender allows for multiple windows to be open you might want to set up some 

ODIFYING YOUR WORK SPACE **based on default install** 

Blender is designed to let you create a workflow suited to you, to that end you can 
ing. 

First off ‘User Preferences’:  Since you’ll want this to access and save files it’s good to 

A note before going further, in a default install, the two top ‘3D View’ work areas have 

t menu’s Work Area is hidden, and the two 3D View 

NHIDING/HIDING AND LOCATING A HEADER BAR 
dow whose menu you 

dd 

your 

Locating the Header Bar  Move to the far left side of the Header Menu Bar you wish 

to test more actions.  Many of the functions and actions are not designed for modeling so 
will not be covered in this paper, or in some cases to the depth needed to fully understand 
their uses. 
 
  
for different ‘Types’ to help your modeling workflow. 
 
 
M
 
  
increase the number of ‘Windows’ you have and position and resize them to your lik
 
  
have, but since you usually don’t change a lot of options once you set them best to do like 
default and hide the work area when not needed. 
   
**
NO ‘Header Bar’s.  Many people at first believe the ‘User Preferences Menu Bar’ is 
the menu for those windows. 
  But as you learned above tha
windows are in reality not set to display their Header Menu Bars. 
 
U

  Move to the left hand edge of the win
want to unhide or ‘Add’, and right click (RMB).   A small 
menu pops up under the cursor, Split Area – Join Areas – A
Header, slide over to ‘Add Header’ and click.  Your 
Header/Menu now appears.  Use this to hide or show 
Header/Menu to your liking.  If a Header Menu is showing 
then ‘No Header’ will be the last choice. 
 
 –

to change location for.  Just the other side of the Window Type Icon is fine then right 
click (RMB), a pop up asks for Header Top-Header Bottom-No Header.  Your choice. 
 



 
 
SPLITTING-JOINING WINDOWS 

we’ll use one of the small upper ‘3D View’ 
le, 

PLITTING WINDOWS  
we will ‘Split’ the lower long 3D View window, by first 

lit 

 

  This can be done to any ‘Window’ by 
windows.  Now some of you may like to have as large a modeling window as possib
while others prefer the standard 4 views found in other 3D programs.  So first let’s take 
the Default three ‘3D View’s and create four Windows. 
 
S
   To create a fourth window 
clicking in that window to make sure it’s the one selected.  Since we want a vertical sp
you must go to the top edge of the window, going to the side will cause a horizontal 
split.  Now right click (RMB) and choose ‘Split Area’ from the pop up menu.  Under 
your cursor is now the window splitting tool, so slide it along the edge till you have the
window size you desire and click to ‘Split Area’. 

 
 

OINING WINDOWS 
er Windows together by first going to a shared edge between 

d 

 your 

 
J
  Use this to join to Blend
two windows, place your mouse cursor on the edge so it turns into an up/down arrow an
right click (RMB).   The Split/Join menu shows so select Join and one window will 
darken and display a large arrow shape in it.  Move your mouse slightly and the 
‘Window’ it can join to darkens. Click in either Window, but on a Up/Down join
Header Bar location comes from the non-darkened Window.  



NOTE: When Joining the two Windows they must be of the same Type.  Also remember 
they must share an edge between those two Windows.  If using the image above were we 
had set up a Blender UI with five 3D View Windows; A-A can join, B-B or A-B combos 
were one was above the other would Join.  However the lower/left B can not Join with 
the upper/right A, no shared edge between them. 
  Also the shared edge must be inclusive between the two Windows being Joined, the 
middle A does share an edge with the New Window, but middle B shares the same edge 
with the New Window so you can’t join them. 
 
BUTTONS WINDOW ALIGNMENT 
  Ok, this is for people who might 
like your UI to resemble other 3D 
programs like Max and Maya.  A 
number of modeling actions you 
carry out are located in the Buttons 
Window Type.  You may like to 
form a long window out of this one 
and locate it off to the right hand 
side, giving your Blender a look 
you might be more accustom to 
working in. 
  Here I simply took a long window 
and moved it over to the right hand 
side.  I then made it a Buttons Type 
Window, and right clicking (RMB) 
in an open area brought up the Panel Alignment pop up.  From its list I chose Vertical to 
align the Buttons Type Window sub-menu Panels into a vertical alignment.   
  Does have some problems in that further options and actions chosen from the sub menus 
need windows that don’t fit this size.  In Max or Maya many of these would appear in 
pop up windows, but this is not the case in Blender. 
 
 
THE 3D VIEW WINDOW TYPE  
 



  This is your 3d modeling working area, where you will build and manipulate 3D objects 
like meshes and curves. 
 
The ‘Tool Box’ or ‘Hot Box 
/Marker Menu’ in 3D View 
   Like with Maya having a 
‘Marker Menu’ that allows you 
to easily bring up a pop up m
through which you can carry o
many common modeling 
without going to the menu bar.  
Blender has such a system 
available in the 3D View 
Window Type, referred to
‘Tool Box’.  Most ‘Actions’ yo
in a 3D View can also be done in Blender using the ‘Tool Box’.  This is a pop up that 
appears under your mouse cursor when it is held down while you are not on or too near
scene objects.  The keyboard shortcut is the ‘Space’Bar. 
  The ‘Tool Box’ is available in the Modes

enu, 
ut 

actions 

 as the 
u can do through the Header Menu Bar while working 

 

 of ‘Object’ and ‘Edit’, and notice the Menu 
 

area, and will hide their Header 

ETTING AROUND THE 3D VIEW WINDOW (3 button wheel mouse) 

- This is a Dolly Move and not just a zoom.  In a zoom the 

r movie 

 View –Window View 
he view 

 the 

. 
w 

you need a Camera in the 

e, 

Items can have sub-lists, and how ‘Actions’ found in the Header Bar ‘Object’ and ‘Mesh’
hot panel areas are about the same as those found here. 
  Many advanced artists like to maximize their working 
Menu Bar and use keyboard shortcuts and the Tool Box instead.  If you want, when you 
see a command like Mesh >Transform >Warp while in ‘Edit’ Mode, which means click 
‘Mesh’ Hot Area >select ‘Transform’ action from list; and chose ‘Warp’ from the sub-
list.  You can try using the ‘Tool Box’ to get to these commands as well. 
 
G
MMB (Middle Mouse Button):  Rotate View 
Shift MMB:  Move/Pan view 
Ctrl MMB: Zoom/Dolly view 
view location stays the same but optically you are zooming in your view area by 
changing focal length.  A Dolly is as if your view point was a camera on a track o
term Dolly, and this camera is actually moving in and out of the area changing its 
distance from the object.   
 

3D
  In Blender you can chose t
for the Window.  To do this use
‘View’ hot area panel on the 
Header Menu Bar for that window
  Click on ‘View’ to set the Vie
Type, but 
scene to View from one.  Also the 
‘Side’ view is from the Right Sid
and there is no Left view. 



  Anytime you rotate a Window View you go immediately into User View.  
 turn on 

FORMATION/HEADER MENU BAR 

ONS

  In the User Preferences Useful Tips above in this paper it tells you how to
View names. 
 
 
IN

       Here is the HEADER MENU BAR for the 3D View Window in ‘Object’ Mode. 
 
 
 
IC  

ets MODE TYPE for window, you click here to change type to Buttons for 

OT AREA:  Clicking on one of these ‘Hot Areas’ (a hot area simply means a 

’. 

You may also wish to try using the ‘Tool Box’ (go to an open area and click and hold a 

ODE:  Lists ‘Mode’ available for Window Type. 
g, joining, or Booleans. 

and  
ges-        

t – select and carry out UV operations on selected Faces. 
 Programs.   

l  

inned meshes used in animation. 

HADING MODE: Lists types of shading available for 3D View. 
e.  Or another way to  

y just its Edges. 

TYPE: S
example. 
PANEL H
defined area under the word is associated through code to perform and action if clicked 
upon.) brings up a list of ‘actions’ associated with that ‘Panel’.  The small arrow to the 
left hides/shows ‘Actions’.  Click on each to see a list of ‘Actions” for each, and move 
over the ‘Actions’ to see they may branch down into further sub-actions. 
  Also take note that where available a keyboard shortcut is listed by the ‘Action
 
  
mouse button till the ‘Tool Box’ appears, or press the ‘Space’ bar) to see if you can 
figure out how to get to the same action. 
 
M
  Object – do ‘Actions’ to an object(s) such as groupin
  Edit – where you carry out ‘Actions’ or modifying of object sub-components 
             values.  For mesh modeling this means ‘Actions’ carried out on Vertices-Ed
             Faces. 
  UV Face Selec
  Vertex Paint – add color to vertices, similar to vertex lighting in other 3D
             But when working with 3D Engines remember lighting is vertex brightness leve
             on a grey scale, and vertex color is the saturation level of color in the vertex. 
  Texture Paint – not fully implemented yet. 
  Weight Paint – paint vertex weights onto sk
 
S
  Bounding Box- a box replaces the object which represents it volum
              think about it is a box equal in length-height-width of the greatest x-y-z distance  
              of the mesh displayed. 
  Wire Frame – mesh displayed b



  Solid – object is flat shaded based on its diffuse color and world light only. 
ll scene  

 based on bitmap texture, however procedural textures do not show. 

xtra Draw Modes:

  Shaded – color still based on diffuse color, but lighting effects are based on a
               lights. 
  Texture – color
 
E  

In your Buttons Window > Panel-Object > 

 

r 

ws transparent texture to 

 Show Edges in 3dsMax, overlay

  
VOT:  Locates where your pivot is located for carrying out ‘Transformations’ 

i as if there is a bounding box around selected objects  

Median Point – unable to find basis for placement, similar to bounding box, but seems    

3D Cursor – locates pivot at location in 3D space at the 3D/Marking Cursor. 

Individual Centers – calculates a pivot as if for an object made from the selected sub- 

Active Object – sets pivot at pivot point of the selected object or sub-object, or if   

OVE OBJECT CENTERS ONLY:  can not find affect of this Icon. 

 TRANSFORM MANIPULATORS  ‘Ctrl Space’ 
lowing it 

Circle – Rotate 

 
  
Draw you will see in addiction to Layers 
and Draw Type that you have some Draw
Extra buttons.  So mode your mouse over 
each Icon to see what each does. 
  Two that might be helpful in you
modeling are: 
TRANSP – allo
show in the 3D View, but can slow down 
draw time. 
Wire – Like s a wireframe image of the mesh over the 
solid displayed object. 
 

PI
of Rotation and Scaling. 
ng Box Center – calculates   Bound

  and places a Pivot at that Bounding Boxes center. 
 
  
  like the actual geometry is being used and not a surrounding box.          
 
  
 
  
  objects.  
 
  
  multiples selected the last object or sub-object selected.       
 
M

 
3D
The Hand Icon hides/unhides the three manipulators fol
on the Header Menu Bar. 
late or Red Triangle – Trans

Move 
Green 
Blue Square - Scale    



  The image to the right shows the look of the manipulation gizmo when each 
tion Axis’ 

RANSFORM ORIENTATION MODE 
 are applying transforms to. 

d view with Z= 

ocal – The axis belonging to the object being transformed is used, however this reflects 

ormal – In “Edit’ Mode the axis is based on the selected sub-objects normal direction.  

ws same as the Local axis.  Also in sub-object mode 
 

iew – All 3D View Windows get treated as if they are flat orthographic planes with  
an 

LAYERS: Layer Visibility (Object Mode) - Think of ‘Layers’ as 

re 
n   

 see the ‘Layer Visibility’ icons. 
 

made visible. 

‘Transform’ is selected.  The gizmo’s color references the color of the ‘Orienta
(red X, green Y, blue Z) as set in the ‘Transform Orientation’ mentioned below.  The 
‘White’ circle allows for manipulation of the object along more than one axis at a time.  
Try manipulating your object/Cube.    
 
T
  Here you set the orientation of the axis you
  Global - Axis aligned to the building grid/plane, sometimes called Worl
  Up/Down, X= Left/Right, Y = In/Out. 
 
L
any rotational manipulations the object has under gone. 
 
N
If more than one sub-component is picked Blender calculates an angle averaged from 
those of the sub-objects selected.   
  Note: If in ‘Object’ Mode this sho
Normals are based off faces.  So sub-objects like Edges and Vertices that share more that
one face will have an axis calculated off of the Faces it’s a component of. 
 
V
Y= Up/Down, X= Left/Right, Z= In/Out.  Notice how Y and Z are the opposite here th
in Global Orientation. 

 
 
 

being like pages in a book stacked on top of one another, familiar 
to users of Lightwave or Maya.  And like a book’s pages whe
t information, so can ‘Layers’ in Blender contain different objects.

Example:  In a scene you might want all lights in one ‘Layer’, all Level objects in a 
different one and each character in their own. 
  Towards the far right of the Header Bar Menu you

each can hold differe

There are twenty shown, and a dark icon means it is visible, and more than one can be



  In Blender there are two main ways to Move and object into a ‘Layer’, first pick a 
‘Layer’ (simply click on one of the small squares, there are twenty) and create the object 

object to another, and to do this be in ‘Object’ Mode with 

d
A pop up appears which look t 

ow go to the ‘Header Menu Bar – Layer Visibility’ and click on and off your old and 
ew Layer to see if your object actually moved.  

 
 

ROPORTIONAL EDIT FALLOFF: ‘Shift o’ (Edit Mode) 
  Proportional editing would be called ‘Soft Selection’ in 

 

cted being, with On all Vertices 
lat

d are influenced. 

he falloff 
fluences the Vertices.  So with the version used here 2.4, this is very much a guess as to 

ich relates to the 
pe/amount of Falloff.  Rather then explain it here simply click the Icon for Falloff type, 

uence it 

there. 
  Secondly you can create in one ‘Layer’ then move the 

the Object(s) you which to move to a different ‘Layer’ 
er Bar do Object >Move to Layer, or ‘m’ on the keyboard. 

s like the ‘Layers’ visibility Icon from the Header Bar bu
with ‘OK’ at the end of it.  You simply click the blueish icon for the Layer you want the 

selected.  Then from the Hea

items Moved to and hit ‘OK’. 
 
 
 
N
n

P
  
Max or Maya, or you pick one or more vertices and based on 
the level of falloff vertices close those selected are affected
as well by transforms. 
  The icon has Off –On -Connected as choices, difference 
between On and Conne
within the distance of influence of those selected are manipu
Vertices that could be connected by edge to those selecte
 
NOTE:   Unfortunately currently Blender does not show in Window how t

ed.  For Connected only 

in
how to decide how other non-selected vertices are influenced by the Falloff. 
  Remember that this works in Edge and Face Modes as well, because Blender is using 
the Vertices that belong to those Edges and Faces selected. 
 
  When Proportional Falloff is On another icon appears wh
ty
the shape/rate of the Falloff is shown by a small Icon depicting the type of infl
will have. 



 
  To increase/decrease the influence Falloff you use the ‘PageUp’ and ‘PageDown’ keys, 

ut keep in mind you have no way of seeing this influence represented in the 3D View 

 SUB-OBJECT/COMPONENT: (Edit Mode)  These three Icons 
represent from left to right Vertices Mode – Edge Mode – Face Mode. 

LIMIT SELECTION TO VISIBLE:  (Edit Mode) 
  As the name implies when on it limits the sub-objects you can select (especially 

e in the 3D View Window, 
 

 
WINDOW:  

  Renders the view as seen from the 3D View Window of the Header Bar from 
 should not to be confused with the ‘Render’ 

 o
>Rende

S TO KNOW: 
1) ‘Ctrl UpArrow’ maximizes and minimizes a Window. 

ects are created where it 
is located, and during a ‘Action’ such as ‘Spin’ the line used to spin 

 
 

ore in part 2. 

b
Window. 
 
 

Clicking one puts you in the Editing Mode for that Sub-Object. 
 
 
 

if you’re using a Marque or Lasso) to only those visibl
depth buffering. 

RENDER THIS 

base on

which the Icon is activated.  And
shown n the User Preferences Menu Bar, or 3D View Header Bar action of View 

r Preview.  Both of which use a scene Camera for their render’s point of view 
used in the render. 
 
HELPFUL THING

 
2) This is the Marking/3D Cursor, New obj

the shape uses its location to base its lathe axis on.  You need to 
understand this Cursor occupies 3D space.  

 M


